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Chapter 18: Send to MS Office 

Introduction 
The Send to MS function under the Export menu allows you to export the 
current analysis to a MS Word or MS Excel file with a pre-defined 
template.  This chapter will discuss the following: 

 Export an analysis to a predefined Word template from TOPS 
 Export an analysis to a predefined Excel template from TOPS 
 Create a new Word template for use with TOPS data 
 Create a new Excel template for use with TOPS data 

 
 

MS Office Templates 
TOPS Pro comes with Word and Excel templates pre-formatted to 
display graphics and statistics from a TOPS analysis.  These templates 
contain special bookmarks (for Word) and field names (for Excel) to 
refer different data from the analysis.  Please refer to Appendix G for a 
list of bookmarks and field names used for Word and Excel respectively. 
 
The MS Office templates for TOPS are saved in the  
\TOPSAPPS\TOPSPro\msword\ folder and can be easily modified to 
display data in the desired format.  You can also design new templates 
from an existing document and apply relevant bookmarks or field names 
at the corresponding locations.  
 
For any newly created templates, they have to be saved in the same folder 
as referenced above in order for TOPS to display them as selection in the 
Send to Select template to export dialog box. 
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Export to MS Word 
In this example, we will use sample analysis Cookies(Boxed and 
Palletized) to illustrate the send to MS Office function.  Go to the File 
menu and select Open. 

1. At the Open Analysis dialog box, select Cookies(Boxed and 
Palletized) under the Approved section of list in the Main Folder and 
click on OK. 

2. The saved analysis will be opened as pictured below. 
 

 
 

3. Go to the Export menu and select Send to MS Office or click on the 
 icon on the tool bar.  This opens the Select template to export 

dialog box as pictured below. 
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4. Highlight XMLWord.dot and click on OK. 

5. TOPS will instruct your system to open MS Word. 
 
Note: You might see a security warning as shown below depending 
on the security setting in your MS Word.  
 

 
 

6. Click on Enable Macros if you see the above message to proceed with 
data export from TOPS to Word. 

7. MS Word will start placing different data at assigned locations and 
when done, you’ll see a three page document as pictured below. 
 

  
8. Save the document as desired using Word’s File, Saved as function. 

 

Note:  To enable Macros in MS Word 2007, please follow these steps: 

1. Click the Microsoft Office Button , and then click on Word Options.  

2. Click Trust Center, click Trust Center Settings, and then click Macro Settings. 

3. Click Enable all macros. 
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Export to MS Excel 
In this example, we will again, use sample analysis Cookies(Boxed and 
Palletized) to illustrate the send to MS Office function.    

1. Go to the File menu and select Open. 

2. At the Open Analysis dialog box, select Cookies(Boxed and 
Palletized) in the Main Folder and click on OK. 

3. The saved analysis will be opened. 

4. Go to the Export menu and select Send to MS Office or click on the 
 icon on the Tool Bar.  This opens the Select template to export 

dialog box as pictured below. 
 

 
5. Highlight TOPSSampleTemplate.xls and click on OK. 

6. TOPS will instruct your system to open MS Excel. 

7. MS Excel will start placing different data at assigned locations and 
when done, you’ll see a worksheet with the following layout. 
 

 
8. Save the document as desired using Excel’s File, Saved as function. 
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Create a Custom Word Template 
To create a custom Word template for TOPS Pro, these are the steps you 
should follow: 

 Copy an existing Word template from TOPS system 
 Format the document to the report format as desired 
 Place data and graphic using TOPS bookmarks in corresponding 

locations 
 Save the document as a Word template in 

\TOPSAPPS\TOPSPro\msword folder 
 

Followed are the instructions in more detail: 

Copy Blank.dot to MyTemplate.dot 
1. Right click on the My Computer icon on your desktop and select 

Explore on the pop-up menu. 

2. Navigate to the folder where document templates for TOPS Pro were 
installed (normally \PROGRAM FILES\TOPSAPPS\TOPSPRO\msword\ 
folder) as pictured below. 
 

 
3. Right click on the document Blank.dot and select Copy at the pop-up 

dialog box. 

4. With the mouse button anywhere in the folder list, right click the 
mouse button and select Copy at the pop-up dialog box as pictured 
below. 
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5. A new file call Copy of Blank.dot will be created. 

6. Right click on the new file Copy of Blank.dot and select rename at 
the pop-up dialog box. 

7. When the filename is highlighted, edit the text to “MyTemplate.dot” 
and press Enter on the keyboard. 

We have just created a new blank template file named MyTemplate.dot in 
the \TOPSAPPS\TOPSPro\msword\ folder. 
 

Format the Template 
In this illustration, we are using Word 2003 and references are also 
provided for Word 2007.  If you are using other versions of Word, please 
use the corresponding commands. 

1. Right click the file MyTemplate.dot and select Open in the pop-up 
menu to open it in Word. 
 
Note:  Make sure that you open the dot file as instructed or directly 
from within Word.  Double clicking a dot file would only create a 
new document file based on the dot file but not opening the dot 
file. 

2. Click on Enable Macros to use macros created for the template file.  
You will see a new blank document opened in Word. 

3. Note that there is a new menu item “Tops” in the Menu Bar and when 
clicked on gives the option Tops Bookmark as pictured on the next 
page. 
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In Word 2007, you will find “Tops” under the “Add-Ins” menu.  
Click on this menu and then click on the drop down arrow next to 
“Tops” to view the defined bookmarks. 

 
4. Format the new Word report as needed.  In the sample report below, 

the different areas contain statistics and images from TOPS as 
pictured below. 
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Add Tops Bookmarks 
To add the graphics and statistics in the marked area, we will use the 
Tops Bookmarks saved in this word template file.  A list of Tops 
bookmarks is available in Appendix G. 

Before adding the bookmarks, please make sure bookmarks ( I ) are 
visible within Word.  Go to Word’s Tools menu and select Options…, 
make sure the Bookmarks check box under the View tab is checked as 
pictured below.  Click on OK to save the setting. 

 

In World 2007, click the Microsoft Office button  and then click on 
Word Options. Click Advanced and then scroll down to the Show 
document content section and check “Show Bookmarks”. 

 
 
In this example, we will add the following bookmarks in the highlighted 
areas of the report as shown on the previous page: 

 Area 1: Shipcase length in inches (STATS_SHIPPER_LEN) 
 Area 2: Shipcase cube in cubic inches (STATS_SHIPPER_CUBE) 
 Area 3: Number of shipcase per layer (STATS_UL_PER_LAYER) 
 Area 4: Unitload 3D view (IMAGE_UL_SINGLE_STACK_3D) 
 Area 5: Intermediate Pack 3D view (IMAGE_IP_SINGLE_STACK_3D) 
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1. To insert Shipcase length in inches, click in the area marked , go to 
Tops menu and click on Tops Bookmarks.  The Tops Bookmarks 
dialog box, as pictured below, appears. 
 

 
 
Note that you can also check the Show All bookmarks option in this 
dialog box to show added bookmarks in the document. 

2. Click on the drop-down list, scroll though the list and highlight 
STAT_SHIPPER_LEN; click on the Add button as pictured below. 
 

 
3. The text cursor ( | ) now changes to a bookmark indicator ( I ) in the 

highlighted above. 

4. Now select bookmark STATS_SHIPPER_CUBE from the list, click on 
the Shipper Cube field, area  and click on the Add button in the 
TOPS Bookmarks dialog to add the bookmark. 
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5. To add shipper per unitload layer, select STATS_UL_PER_LAYER 

from the list, click on the area as pictured below and click on the Add 
button in the TOPS Bookmarks dialog to add the bookmark. 
 

 
6. To add the intermediate pack 3D graphic, select 

IMAGE_IP_SINGLE_STACK_3D from the list, click on the area as 
pictured below and click on the Add button in the TOPS Bookmarks 
dialog to add the bookmark. 
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7. To add the unitload 3D graphic, select 

IMAGE_UL_SINGLE_STACK_3D from the list, click on the area as 
pictured below and click on the Add button in the TOPS Bookmarks 
dialog to add the bookmark. 
 

 
8. After all 5 bookmarks have been added, go to Word’s File menu and 

select Save to save the changes to the MyTemplate.dot file.  Exit MS 
Word.  This template is now ready for use in TOPS. 

9. Now go back to TOPS Pro, with the current analysis Cookies(Boxed 
and Palletized) still open, go to the Export menu and select Export to 
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MS Office.  You should now see the MyTemplate.dot under the list of 
available Templates. 

10. Highlight MyTemplate.dot and click on OK. 

11. MS Word will open with the Security Warning message.  Click on 
Enable Macros and a new document using the selected template will 
be open as pictured on the next page.   
 
Note the five areas we have bookmarked are now populated with the 
corresponding data and graphics. 
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Tips on Using Bookmarks in MS Word 
1. The TOPS menu on Word’s menu bar or under its Add-Ins menu is 

only available when you open the template file in the 
\TOPSAPPS\TOPSPro\msword\ but not a word document based on 
the TOPS template file.  

2. If you want to review an assigned bookmark in a Word template, go 
to Tops menu and open Tops Bookmarks.  Place the text cursor next 
to the bookmark, the Tops Bookmarks dialog box will display the 
name of the bookmark. 

3. To delete an assigned bookmark, follow tip #2 above and then click 
on the Delete button.  The bookmark cursor ( I ) will be removed. 

4. The state of the Add, Delete and Goto buttons – active or being 
grayed out – gives you the hint if the selected bookmark has been 
assigned in the template.   

 When the Add button is active -  the selection has not been 
bookmarked 

 When the Add button is inactive (gray out), the selected 
bookmark exists in the current document.  Click on the Goto 
button to bring the text cursor to the selected bookmark, then 
click on the Delete button should you want to remove the 
bookmark.  
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Create a Custom Excel Template 
In MS Excel, TOPS data, including both images and statistics, are placed 
into designated cells defined by Range Names.  These names are similar 
to bookmarks in MS Word and given cell references for placement of 
different data. 

The TOPSSampleTemplate.xls provided with TOPS contains defined 
names for most statistics and most 3D images from different stages of a 
TOPS analysis.  The easiest way is to adapt this template and redefine the 
cell reference for data placement. 

Please follow these instructions to create a custom Excel template.  

 Save a copy of the TOPSSampleTemplate.xls to a new file and make 
sure it is saved in the \TOPSAPPS\TOPSPRO\msword\ folder 

 Change the layout of the worksheet as desired 
 Change the cell reference of the Range Names  

 

Create & Format a New Worksheet in Excel Template 
1. Open Excel, browse to the folder \TOPSAPPS\TOPSPRO\msowrd\ 

and open TOPSSampleTemplate.xls as pictured below. 
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The circled area is called is the Name Box and displays any name 
defined for the active cell (C5 in this example on the previous page). 
 
If you click the drop down triangle next to the Name Box, you will 
see a list of names defined in the current workbook. When you click 
on any of these names, Excel will go to the cell or cell range where 
the name is referenced.  For example, the name 
IMAGE_SC_POPTOP_3D refers to the cell G15 which has been 
merged to two columns on its right and nine rows beneath it. 
 

 
2. Go to File menu, select Save As and enter “New TOPS Template.xls” 

in the File name field and click on the Save Button to save the sample 
template under the new name. 

3. Now insert a new worksheet in current workbook by going to the 
Insert menu and then select Worksheet.  A new worksheet called 
Sheet2 will be added. 

4. Go to Sheet2 and create the report layout as desired.  An example 
similar to the one created in MS Word example is pictured on the 
next page. 
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Assign New Cell References 
In this illustration, we are using Excel 2003.  If you are using another 
versions of Word, please use the corresponding commands.  There are 
two ways to assign new cell reference to defined names: 

 Go to the Insert menu, select Name and then Define.  Change the cell 
reference to the new worksheet and new cell. 

 Drag and drop existing cell content from the existing worksheet 
(Output) to the new worksheet (Sheet2). 
 
Note:  The source and target cell need to be of the same dimension.  
Note: To drag across worksheet, bring the mouse cursor to the 
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worksheet tabs and press the [Alt] key to highlight the new 
worksheet, release the [Alt] key when you are in the new worksheet.  
You will need to keep the left mouse button pressed all this time with 
the cell content until you reach the destination cell in the new 
worksheet. 
 
Note:  When using the drag-and-drop method, any cell formatting 
will also be brought over to the new cell. 

We will illustrate the first method of changing cell reference using the 
menu function. In this example, we will add the following in the 
highlighted areas of the report as shown on the previous page: 

 Area 1 (cell B21): Intermediate Pack pop top 3D view 
(IMAGE_IP_POPTOP_3D)  

 Area 2 (cell G21): Unitload 3D view 
(IMAGE_UL_SINGLE_STACK_3D) 

 Area 3 (cell C16): Shipcase outside length dimension (SCOUT_LEN) 
 Area 4 (cell H16): Number of shipcase per layer 

(UL_CASESPERLAYER) 
 Area 5 (cell H17): Number of shipcase layer per pallet 

(UL_LAYERSPERLOAD) 
 

1. Go to Insert menu, select Name and then Define, the Define Name 
dialog box appears as pictured below. 
 

 
2. Scroll down the list until you see IMAGE_IP_POPTOP_3D.  The 

Refers to: field shows  “=Output!$D$15” – the cell reference in the 
existing sample worksheet. 

3. With the name highlighted, change the reference field to 
“=Sheet2!$B$21” as pictured on the next page and click on the Add 
button. 
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4. Next, highlight IMAGE_UL_SINGLE_STACK_3D and change the 

reference to “=Sheet2!$G$21” and click on the Add button. 
 

 
5. To assign new reference to shipcase length, select SCOUT_LEN from 

the list and change the cell reference to “=Sheet2!$C$16” and click 
on the Add button. 
 

 
6. Repeat the step and assign UL_CASESPERLAYER to cell Sheet2!$H$16 

and UL_LAYERSPERLOAD to cell Sheet2!$H$17 respectively. 

7. Click Ok to close the Define Name dialog box. 

8. Save the workbook and exit MS Excel. 

9. Now, go back to TOPS Pro and open analysis “Cookies (Boxed and 
Palletized). 
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10. Click on the Send to Excel icon  on the tool bar to open the Select 
template to export dialog as pictured below. 
 

 
11. Select New TOPS Template.xls and click on the OK button. 

12. MS Excel will open displaying the contents of the Output worksheet 
in the workbook.  Click on the Sheet2 tab to view the new populated 
report as pictured below. 
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Tips on Using TOPS Templates in MS Excel 
1. Make sure the Excel template is saved in the 

\TOPSAPPS\TOPSPro\msword\ folder in order to appear in the 
template list in TOPS Pro. 

2. You can hide the Output worksheet from the workbook so it will 
show your report on Sheet2 right away.  To do so, click the tab 
“Output” to make it active, then go to Format menu, select Sheet and 
then Hide. 

3. The Name Box shows all Names used in the current workbook.  To 
view all available defined names, including those with no reference, 
you’ll need to go to the Inset menu, select Name and then Define. 

4. Do not delete any Defined Names in the workbook. 

5. If you need images that are not currently defined, please contact 
TOPS technical support. 


